




 

 

Цель лабораторной работы:   

Изучение возможностей надписывания объектов и преобразование 

надписей в аннотации в среде ArcMap. 

 

Задание 

1. Изучите в пункте 2.1. способы отображения количественных 

данных. 

2. Изучите в пункте 2.2. виды использования уровней символов 

и маски слоя. 

3. Выполните упражнения 1-7 в пункте 3, таблицу вариантов, 

для усвоения теоретического материала по использованию приложений 

ArcMap и ArcCatalog для изучения пространственных отношений между 

объектами.  

4. Приведите результаты работы в отчете.   

 

 1.Содержание отчета. 

♦ титульный лист; 

♦ задание; 

♦ картографические слои, сохраненные после выполнения каждого 

упражнения 3.1-3.7.  
 

2. Основные понятия. 

2.1. Способы отображения количественных символов. 

 
 



 

 

 
 

 
  2.2. Использование уровней символов и маски слоя. 

 



 

 

 
 

 

3. МЕТОДИЧЕСКИЕ УКАЗАНИЯ ПО ВЫПОЛНЕНИЮ ЗАДАНИЯ 

3.11. СПОСОБЫ ОТОБРАЖЕНИЯ КОЛИЧЕСТВЕННЫХ ДАННЫХ. 

Существует множество способов отображения значений атрибутов и 

концентрации объектов на карте. В лабораторной работе №11 вы 

использовали только метод Цветовой схемы (Color ramp) для отображения 

соотношения численности детей в возрасте пяти лет на картах переписи 

населения округа Тилламук. Теперь вы сравните эффективность 

использования способа градуированных символов и точечного способа 

при отображении количества жилых фургонов (домов на колесах) в 

различных округах штата Техас. Вы также узнаете как улучшить 

отображение символов линейных объектов с помощью расширенных 

возможностей рисования. 

□ Откройте ArcMAP с новой пустой карты и щелкните на кнопке 

Добавить данные (AddData) и перейдите в базу геоданных С: 

\Student\igis2\National и добавьте класс пространственных объектов 

USA_Counties. 

□ Воспользовавшись диалоговым окном Выбрать по атрибуту 

(Select by Attributes), создайте запрос для выбора округа по Вашему 

варианту из слоя USA_Counties. 

Используйте поле Name для выбора округа. 

□ Нажмите Применить (Apply), а затем закройте диалоговое окно 

Выбрать по атрибуту (Select By Attributes). 

□ Когда округ выбран, увеличьте масштаб до выбранного объекта и 

снимите выделение с выборки. 

□ Теперь, помимо своего округа, вы хотите увидеть близлежащие 

округа, поэтому измените масштаб изображения на 1:3 000 000 

□ Надпишите округа по полю NAME, воспользовавшись свойствами 

текста, предлагаемыми по умолчанию. 



 

 

Сначала вы отобразите количественные данные с помощью 

градуированного символа (Graduated symbols). 

□ Откройте диалоговое окно Свойства слоя USA_Counties (Layer 

Properties) и щелкните на закладке Символы (Symbology), затем выберите 

Количество (Quantities) > Градуированный символ (Graduated symbols) 

для типа отображения. 

□ В качестве отображаемого Значения (Value) выберите из 

открывающегося списка поле MOBILEHOME (оно находится в нижней 

части списка). 

В атрибутивном поле MOBILEHOME отражено количество жилых 

фургонов для каждого округа. Обратите внимание, что по умолчанию 

значения классифицируются с использованием метода естественных 

границ (Natural Breaks) на пять классов. 

□Нажмите ОК в диалоговом окне Свойства слоя (Layer Properties). 

Далее, вы нормализуете атрибутивные значения из поля 

MOBILEHOME, чтобы получить другое представление данных. 

□ Откройте диалоговое окно Свойства слоя (Layer Properties) для 

USA_Counties. 

□ В закладке Символы (Symbology), в разделе Нормирование 

(Normalization), выберите из открывающегося списка поле POPI999, затем 

нажмите ОК. 

При нормировании значений MOBILEHOME, вы делите их на 

численность населения в соответствующем округе за 1999 год. Теперь 

вместо значения абсолютного количества жилых фургонов вы 

располагаете значением количества фургонов на одного человека. 

Обратите внимание, как изменения отразились на отображении данных. 

Еще один способ для отображения конкретного значения атрибута - это 

Точечный способ (Dot density). 

□ Откройте последовательно USA_Counties > Свойства 

(Properties) > Символы (Symbology), затем выберите Количество 

(Quantities) > Точечный способ (Dot density). 

□ В разделе Выбор поля (Field Selection) выберите MOBILEHOME, 

затем щелкните на стрелке, указывающей вправо, чтобы добавить его в 

список отображаемых атрибутов. 

Обратите внимание, что предлагаемый по умолчанию размер точки 

- 2, а ее вес - 40. 

□Нажмите ОК. 

ПРИМЕЧАНИЕ: Если цвет, предложенный по умолчанию, плохо 

контрастирует с фоном, вернитесь в диалоговое окно Свойства слоя 

(Layer Properties) и для опции Фон (Background) выберите желто-

коричневый цвет (tan) или любой другой подходящий для отображения 

цвет.   Точки случайным образом размещаются внутри каждого полигона. 

Проверить это вы можете несколько раз нажав кнопку Обновить вид 

(Refresh View). Вы заметите, что каждый раз точки меняют 



 

 

местоположение. 

Итак, вы снова представили приблизительную оценку количества 

жилых фургонов для каждого округа, но на этот раз вместо 

классификации, где каждый класс отображается своим символом, у вас 

показаны точки одного размера, каждая из которых соответствует 40 

жилым фургонам. Преимущество данного типа количественного 

представления данных заключается в возможности более точного 

отображения количества жилых фургонов в каждом округе. Для этого 

количество точек нужно просто умножить на их вес. 

3.12. ВКЛЮЧЕНИЕ НАДПИСЕЙ СЛОЯ 

В этом пункте вы подключите надписи для двух слоев, 

пронаблюдаете динамику их отображения при увеличении и уменьшении 

масштаба карты и зафиксируете надписи, используя панель инструментов 

Надписи. 

□ Нажмите в меню  АгсМар, кнопку New Map File  

□ Нажмите Открыть (Open) и перейдите в папку 

igis2\MapDocuments и откройте файл LabelsAndAnno.mxd. 

□ Нажмите правой кнопкой мыши на слое WorldCities (Города 

Мира) и включите опцию Надписать объекты (Label Features). 

□ Нажмите правой кнопкой мыши на слой Страны Мира 

(WorldCountries) и включите опцию Надписать объекты (Label Features). 

□ Поэкспериментируйте с масштабом изображения. 

Обратите внимание на изменение местоположения надписей при 

масштабировании (например, когда вы уменьшаете масштаб, надписи 

исчезают). Расположение надписей объектов определяется специальными 

правилами и свойствами. Вы также можете заметить, что при полном 

экстенте карты на экране отображается сравнительно малое/ количество 

надписей. Если одна надпись мешает полному изображению другой, то 

она может не отображаться вовсе. По мере увеличения масштаба 

появляется больше пространства для размещения надписей и, 

соответственно, большее количество надписей отображается на экране. 

АгсМар использует по умолчанию механизм определения конфликтов для 

управления местоположением и количеством отображаемых надписей при 

их отображении в мелких масштабах. 

Если вы хотите сохранить постоянное положение надписей при 

перемещении по карте, вы можете воспользоваться возможностью 

фиксации надписей, которая доступна через панель инструментов 

Надписи (Labeling). 

□ Выберите последовательно Вид > Панели инструментов > 

Надписи (View > Toolbars > Labeling), чтобы добавить соответствующую 

панель инструментов. 

□ Увеличьте карту до масштаба крупнее, чем 1:100,000,000 (т.е., 

знаменатель масштаба должен быть меньше, чем 100,000,000). 

□ На панели инструментов Надписи (Labeling), нажмите кнопку 



 

 

Зафиксировать Надписи (Lock Labels). 

□ Переместитесь в различные участки карты. 

При перемещении вы увидите, что новые надписи не появляются на 

карте, а текущие надписи остаются на своих местах. Когда надписи 

зафиксированы, нельзя создать новые надписи или обновить текущие. 

Одно из преимуществ этой функции в том, что надписи не двигаются, 

когда вы увеличиваете масштаб, чтобы просмотреть те, которые сложно 

разглядеть в полном экстенте. Если вы не хотите менять экстент или 

текущий вид, вы также можете работать с зафиксированными надписями 

в окне Увеличителя (Magnifier). 

□Нажмите Окно > Увеличитель (Window > Magnifier). 

□При необходимости измените масштаб окна увеличителя на 100%. 

□Поместите окно Увеличение (Magnification) над какой-нибудь 

надписью. 

Обратите внимание, что размер надписей не изменился, и они 

остались на тех же самых местах. 

□ Закройте окно Увеличение (Magnification). 

□Щелкните на кнопке Зафиксировать надписи (Lock Labels), чтобы 

отключить фиксацию. 

Обратите внимание, что все надписи текущего экстента сейчас 

отображаются.  

3.13. ИЗМЕНЕНИЕ ШРИФТА НАДПИСЕЙ 

Вы можете изменять свойства шрифта ваших надписей. В данном 

случае очень сложно увидеть различия в надписях стран и городов. В 

следующем шаге вы выделите надписи городов жирным шрифтом, а 

надписи стран увеличите и сделаете их темно-зелеными. 

□ Откройте свойства слоя Города Мира (WorldCities). 

□ Нажмите на закладку Надписи (Labels). 

 В блоке Символ (Symbol) нажмите кнопку Выбрать Символ (Symbol 

Selector). 

□ В диалоге Выбор символа (Symbol Selector) при необходимости 

Нажмите More Symbol и поставьте галочку на пункте Business, затем 

прокрутите список и выберите символ Город (City) 

□ Нажмите ОК. 

□На панели инструментов Надписи (Labeling) нажмите на кнопку 

Менеджер надписей(Label Manager). 

Менеджер надписей дает вам доступ ко всем свойствам надписей 

каждого слоя вашего активного фрейма данных. Список всех слоев 

находится в левой части диалогового окна, а все свойства перечислены в 

правой части. 

□ В списке Классы надписей выберите WorldCountries >По 

умолчанию {Default). 

□    В блоке Символ (Text Symbol) нажмите кнопку Символ(Symbol). 

□ Выберите символ Country 1. 



 

 

□ Установите темно-зеленый цвет (Peacock Green) шрифта (темно-

зеленый, восьмой столбец, шестой ряд). 

□ Для изменения размера текста из раскрывающегося списка 

выберите 18. 

□ Нажмите Ok в обоих диалоговых окнах. 

На экране вы увидите меньшее количество надписей, поскольку 

названия стран отображены более крупным шрифтом и накладываются 

друг на друга. 

ПРИМЕЧАНИЕ:. С картографической точки зрения размер шрифта 

18 не подходит для масштаба вашей карты. 

□Увеличьте изображение до полного экстента. 

3.14. ИЗМЕНЕНИЕ РАЗМЕЩЕНИЯ И ВИДИМОСТИ НАДПИСЕЙ. 

Когда вы масштабируете карту до полного экстента, прочитать 

надписи становится практически невозможно. Вы зададите диапазон 

масштабов отображения надписей, чтобы отображать надписи только при 

подходящем для рассмотрения масштабе. После установки диапазона 

масштабов вы измените, опции расстановки надписей для городов так, что 

надписи будут появляться только справа от пунсона города, затем вы 

измените расположение надписей стран, поместив их внутри полигонов. 

□ Откройте свойства слоя Города Мира (WorldCities). 

□ На закладке Надписи (Labels) нажмите Диапазон масштабов 

(Scale Range). 

□ Отметьте опцию "Не показывать надписи " ("Don’t show labels when 

zoomed"). 

□ Для Мельче 1: (Out beyond l:) введите 20 000 000. Для Крупнее 1: 

(In beyond Г.) оставьте значение, предложенное по умолчанию. 

Теперь, когда масштаб карты будет менее 1: 20,000,000 надписи 

городов не будут отображаться. 

□ Нажмите Ok в обоих диалоговых окнах. 

□ Увеличивайте масштаб до тех пор, пока не увидите надписи 

городов. 

□ Измените свойства слоя Страны Мира (WorldCountries) так, чтобы 

надписи не отображались при масштабе менее 1:60,000,000 

□ Нажмите ОК, чтобы закрыть все окна диалога. 

□ Перейдите к полному экстенту карты. Затем увеличивайте до тех 

пор, пока не увидите надписи стран. , 

Теперь измените опции расстановки надписей для слоя Страны Мира 

(WorldCountries) так, чтобы для каждой страны отображалась только одна 

надпись. 

□Сфокусируйте отображение вашей карты на Италии. 

□Установите масштаб 1: 25,000,000. Надпись Италия может быть 

продублирована два или три раза. 

□ Откройте свойства слоя Страны Мира (WorldCountries). 

□ На закладке Надписи (Labels) нажмите Свойства размещения 



 

 

(Placement Properties). 

□ Нажмите на закладку Размещение (Placement), если необходимо. 

□ Для копирования надписей нажмите "Размещать одну надпись 

для каждого объекта" ("Place one label per feature"). 

Подсказка: Чтобы узнать, в чем различие между опциями Удалять 

повторяющиеся надписи (Remove duplicate labels) и Размещать одну 

надпись для каждого объекта (Place one label per feature) нажмите кнопку 

Помощь (Help) (на ней отображен знак вопроса ' ?', а располагается она в 

правом углу верхней панели диалогового окна Свойства размещения 

(Placement Properties)). При нажатии на кнопку помощи, изменится 

символ курсора мыши. Нажмите измененным курсором на строку Удалять 

повторяющиеся надписи (Remove duplicate labels) и прочитайте 

контекстную вспомогательную информацию. Тоже самое повторите для 

опции Размещать одну надпись для каждого объекта (Place one label per 

feature). 

□Нажмите OK в обоих диалоговых окнах. 

Обратите внимание, что теперь отображается только одна надпись 

Италия. 

Надписи городов не всегда отображаются справа над пунктом. 

Некоторые расположены прямо над ним, снизу либо не отображаются 

вовсе. Теперь вы ограничите их расположение с правой стороны над 

пунктом города. 

□ В главном меню {Main Menu) ArcMap нажмите Вид > Закладки > 

Европа (View > Bookmarks > Europe). 

□ Откройте свойства слоя Города Мира (WorldCities). 

□ На закладке Надписи {Labels) нажмите Свойства размещения 

(Placement Properties). 

□ Нажмите на закладку Размещение (Placement), если необходимо. 

□ Нажмите Размещать горизонатльно, если не выходит – вдоль 

полигона(Try horizontal first, then straight). 

Обратите внимание на работу Стандартного механизма надписей 

ESRI (ESRI Standard Label Engine): сначала надписи размещаются 

горизонтально там, где есть достаточно места для этого. Если надписи не 

могут быть размещены горизонтально, они располагаются вдоль самого 

длинного направления полигона. Там, где надписи не могут быть 

помещены полностью внутри полигона, они по умолчанию располагаются 

горизонтально. 

3.15. НАДПИСЫВАНИЕ СТОЛИЧНЫХ ГОРОДОВ ДРУГИМ ШРИФТОМ 

До настоящего времени вы изменяли свойства надписей для всего 

слоя. На данном этапе вы сгруппируете надписи внутри слоя по каким-

либо отличительным характеристикам и сможете установить свойства для 

надписей каждой группы. 

Откройте закладку Юго-восточная Азия (South East Asia). 

□ Отключите надписи для слоя Страны Мира (WorldCountries). 



 

 

□ На панели инструментов Надписи (Labeling) нажмите на кнопку 

Менеджер надписей (Label Manager). 

□ В окне диалога Менеджер надписей (Label Manager) в списке 

Классы надписей (Label Classes) включите слой WorldCities. 

Далее вы сгруппируете столичные города в класс надписей Столицы 

(Capitals). Класс надписей - это группа объектов с одинаковыми 

свойствами надписей. Когда вы создаете новый класс, в него переходят 

все свойства надписей из предыдущего класса. В данном случае, свойства 

надписей городов, которые вы использовали в этом упражнении, станут 

свойствами созданного класса Столицы (Capitals). 

□ На панели Добавить класс надписей (Add Label Class) введите 

имя класса Capitals 

 
□ Нажмите Добавить (Add). 

Сейчас созданный класс представляет собой набор всех объектов 

слоя. Чтобы ограничить данный класс только столицами стран, вам будет 

необходимо сделать запрос SQL. 

□ В окне диалога Менеджер надписей (Label Manager) щелкните 

новый класс WorldCities > Capitals. 

□ Нажмите кнопку SQL-запрос (SQL Query). 

□ Постройте выражение "Capital" = 'Y' и нажмите ОК. Теперь 

измените символы для класса Столицы (Capitals). 

□ Измените размер до 10 pt. 

Вы будете использовать цветовую модель RGB для изменения цвета 

надписей столиц. 

□ Нажмите стрелку справа для опции Цвет (Color), чтобы открыть 

палитру цветов. 

□ В палитре цветов (Color palette) нажмите Другие цвета (More 

Colors). В окне диалога Выбор цвета (Color Selector) измените цвет, 

меняя параметры RGB:   137,12,0 

□ Нажмите ОК, чтобы закрыть все окна диалога. Теперь у Вас 

создано два класса для слоя Города Мира (WorldCities): По Умолчанию 

(Default) и Столицы(Capitals). Класс По Умолчанию (Default) включает в 



 

 

себя все объекты, а класс Столицы (Capitals) представляет только столицы 

стран. Так как оба класса включают в себя объекты столичных городов, то 

эти города надписываются дважды. Обратите также внимание, что 

надписи некоторых столиц не отображаются новыми символами из-за 

конфликтов, возникающих при размещении надписей. 

Теперь вы исключите из класса По Умолчанию (Default) столицы 

стран, чтобы они были надписаны один раз. 

□Откройте Менеджер надписей (Label Manager). 

□ В списке Классы надписей (Label Classes) щелкните WorldCities > 

Default. 

□ Нажмите SQL-запрос (SQL Query). 

□ Постройте выражение "Capital" = 'N' и нажмите ОК. 

□Нажмите Диапазон Масштабов (Scale Range). 

□ Для Мельче 1: (Out Beyond 1:) введите 15 000 000.  

□ Нажмите ОК в обоих диалоговых окнах. 

□Измените масштаб карты и переместитесь в различные ее участки, 

чтобы просмотреть классы надписей. 

Теперь вы видите надписи столиц крупным шрифтом темно-

бордового цвета. Чтобы ' увидеть надписи обычных городов, вам 

необходимо установить масштаб отображения крупнее чем 1:15 000 000. 

Они по-прежнему подписаны маленьким черным шрифтом. 

3.16 УСТАНОВИЛЕНИЕ ПРИОРИТЕТА НАДПИСЕЙ 

Вы можете создать приоритет надписей для слоя или класса на 

Вашей карте. Объекты из слоев и классов с большим приоритетом будут 

надписываться в первую очередь. Поскольку приоритет надписей - это 

настройка, которая влияет сразу на несколько слоев, то вы установите 

приоритеты в Менеджере надписей (Label Manager). Сначала изучите 

текущий приоритет надписей. 

□ Включите надписи для слоя Страны Мира (WorldCountries) и 

нажмите OK. 

□ На панели инструментов Надписи (Labeling) нажмите кнопку 

Изменить приоритет надписей (LabelPriority Ranking). 

Обратите внимание, что надписи обычных городов по умолчанию 

имеют больший приоритет, чем столицы. 

□Нажмите Отменить (Cancel), чтобы закрыть окно диалога 

Приоритет надписей (Label Priority Ranking). 

□ Откройте закладку Токио (View > Bookmarks > Tokyo). 

□ Уменьшите масштаб до 1: 15 000 001. Надписи обычных городов 

не отображаются. 

□ На стандартной панели инструментов для масштаба введите 9 000 

000 и нажмите Enter. 

Теперь вы измените приоритеты так, что надписи столичных 

городов не будут исчезать при появлении остальных надписей. 

□ Откройте окно диалога Приоритеты надписей (Label Priority 



 

 

Ranking). 

□ В списке Приоритет надписи (Label Priority) переместите 

Страны Мира -По умолчанию (WorldCountries - Default) в верхнюю 

позицию, используя кнопки со стрелками. 

□ Переместите Города Мира -Столицы (WorldCities-Capitah) на 

вторую позицию в списке. 

Приоритеты должны быть расставлены как показано в окне диалога на 

рисунке: 

 
 

□Нажмите OK. 

 

3.17. СОЗДАНИЕ И РЕДАКТИРОВАНИЕ АННОТАЦИЙ 

На этом шаге вы превратите надписи стран в аннотации. Аннотации 

дают Вам возможность точного контроля за местоположением надписей. 

Когда вы превращаете надписи в аннотации, вы можете либо хранить их с 

картой как слой графики, либо сохранить их в базе геоданных как класс 

объектов аннотаций. 

Для создания аннотации Вам необходимо задать базовый масштаб 

для Ваших  надписей. При заданном базовом масштабе надписи будут 

масштабироваться вместе с картой при ее увеличении или уменьшении. 

Сначала выясните, как приближение и удаление влияет на надписи без 

установки базового масштаба. 

□Откройте закладку Африка (View > Bookmarks > Africa). 



 

 

□ Увеличивайте масштаб до тех пор, пока не появятся надписи. 

□ Увеличьте изображение еще больше, чтобы убедиться, что размеры 

надписей не изменяются при изменении масштаба карты. 

Далее вы зададите базовый масштаб для создания аннотаций. 

□На стандартной панели для масштаба введите 50 000 000 и нажмите 

Enter. 

□ В таблице содержания нажмите правой кнопкой мыши на фрейм 

данных Слои (Layers) и нажмите Базовый масштаб > Установить 

базовый масштаб (Reference Scale > Set Reference Scale). 

С заданным базовым масштабом Ваш текст будет масштабироваться 

вместе с картой. При увеличении масштаба текст будет увеличиваться, а 

при уменьшении, соответственно, уменьшаться. 

□ Поэкспериментируйте с масштабом изображения, чтобы увидеть, 

как изменяются размеры надписей и объектов по отношению к базовому 

масштабу. 

При создании аннотации   текущий масштаб будет использоваться как 

базовый. Увеличьте изображение до заданного масштаба. 

□ В таблице содержания нажмите правой кнопкой мыши на фрейм 

данных Слои (Layers) и нажмите Базовый масштаб > Приблизить к 

базовому масштабу (Reference Scale > Zoom To Reference Scale). 

□ На панели иструментов Надписи (Labeling) нажмите кнопку 

Показать неразмещенные надписи (View Unplaced Labels) . 

Все неразмещенные надписи отобразятся на карте красным цветом. 

При создании аннотации эти надписи не конвертируются, но могут быть 

сохранены в класс аннотаций как новые объекты. Далее выбудете 

управлять неразмещенными аннотациямип, используя Окно 

неразмещенных аннотаций (UnplacedAnnotation Window). 

□ Щелкните кнопку Показать неразмещенные надписи (View 

Unplaced Labels), чтобы отключить эти надписи.  

□ Нажмите правой кнопкой мыши на слой Страны Мира 

(WorldCountries) и нажмите Конвертировать надписи в аннотации 

(Convert Labels To annotation). 

□ Используйте установленные по умолчанию параметры: Сохранить 

аннотацию: в базе геоданных {Store Annotation: In a database) и Создать 

аннотации для: всех объектов {Create Annotation for: All features). 

□ Отключите опцию Объектно-связанные (Feature Linked) и 

убедитесь, что опция Дополнить (Append) не отмечена. 

□ Нажмите кнопку Обзор в поле Класс аннотаций (Annotation 

Feature Class), чтобы вызвать окно Создать класса аннотаций (Create 

Annotation Feature Class). 

□ В качестве базы геоданных {Database) выберите файл 

C:\Student\igis2\National.gdb. 

□ В качестве названия нового класса аннотаций введите 

CountryAnno:<Здесь номер Группы и варианта> и нажмите Сохранить 



 

 

(Save). 

□ Убедитесь, что отмечена опция Конвертировать неразмещенные 

надписи в неразмещенные аннотации (Convert unplaced labels to unplaced 

annotation). 

□ Нажмите Конвертировать (Convert), чтобы создать новый класс 

аннотаций. 

Обратите внимание, новый класс аннотаций добавлен в Таблицу 

содержания. При этом надписи слоя Страны Мира (WorldCountries) 

автоматически отключились. Обратите также внимание, что новый класс 

аннотаций унаследовал диапазон масштабов от исходных надписей, и 

поэтому не отображается в масштабе мельче 1:60,000,000. Вы измените эту 

установку. 

□ Нажмите правой кнопкой на Ваш класс аннотаций Country anno > 

Default. 

□ Нажмите Диапазон видимых масштабов > Очистить диапазон 

видимых масштабов (Visible Scale Range > Clear Scale Range). 

□Перейдите к полному экстенту карты. 

Обратите внимание, что шрифт аннотаций при полном экстенте 

имеет такой же размер, что и в исходном масштабе1:50,000,000. 

□ Вернитесь в предыдущий экстент. 

При преобразовании надписей в класс аннотаций базы геоданных все 

надписи, которые не были размещены из-за правил размещения, хранятся в 

базе геоданных как новый класс аннотаций. Сейчас вы используете Окно 

неразмещенных аннотаций (Unplaced Annotation Window), чтобы добавить 

неразмещенные аннотации. 

□ Для того, чтобы добавить или отредактировать любую аннотацию, 

вы должны начать сеанс редактирования. 

□ Добавьте панель инструментов Редактор (Editor) (Нажмите Вид 

> Инструменты > Редактор (View > Tools > Editor)), если она еще не 

включена, и добавьте также панель инструментов Аннотация (Annotation). 

□ На панели редактирования нажмите Редактор > Начать 

редактирование (Editor > Start editing). 

□ На панели редактирования в списке Целевых слоев (Target) 

выберите свой слой Country_Аппо…., если он еще не выбран. 

□ На панели инструментов Аннотация щелкните на кнопке Окно 

неразмещенных аннотаций (UnplacedAnnotation Window) . 

□ Измените размеры окна и поместите его так, чтобы вы могли 

хорошо видеть Вашу карту и окошки с опциями Видимый экстент (Visible 

Extent) и Отображать (Draw) . 

□ В окне неразмещенных аннотаций из выпадающего списка 

Показать (Show) выберите свой слой. 

□ Поставьте отметки в окошке с опцией Отобразить (Draw) и 

убедитесь, что включена опция Видимый экстент (Visible Extent). 

□ Щелкните на кнопке Искать сейчас (Search Now). ' 



 

 

□ В диалоговом окне Неразмещенные аннотации (Unplaced 

Annotation) щелкните правой кнопкой на неразмещенной аннотации и 

нажмите Приблизить к аннотации (Zoom to Annotation). 

□ Щелкните правой кнопкой по той же аннотации и нажмите 

Разместить аннотацию (Place Annotation). 

Аннотация размещена на карте и удалена из Окна неразмещенных 

аннотаций. Обратите внимание, что неразмещенная аннотация сейчас 

выбранный объект, и ваш курсор принял вид инструмента Редактировать 

аннотацию. 

Используйте инструмент Редактировать аннотацию {Edit Annotation 

Tool) для того, чтобы переместить выбранную аннотацию в более 

подходящее местоположение. 

Список неразмещенных аннотаций будет доступен каждый раз, когда 

Ваш класс аннотаций открывается в документе карты. 

□В Окне неразмещенных аннотаций {Unplaced Annotation Window), 

снимите отметку в окошке опции Отобразить (Draw) и закройте окно. 

Теперь вы будете использовать инструмент Редактировать аннотацию 

для изменения параметров отдельных надписей. Вы можете также 

использовать панель инструментов Действия (Draw) для изменения 

атрибутов текста, таких как размер, цвет и шрифт. 

□ Откройте закладку Россия (Russia). 

□ Используйте инструмент Редактировать аннотацию на панели 

инструментов Аннотация, чтобы выбрать аннотацию "Россия" ("Russia"). 

□ Щелкните правой кнопкой на выбранной аннотации и нажмите 

Атрибуты (Attributes). 

□ В окне Атрибуты проверьте, активна ли закладка Аннотация. 

□ Измените размер шрифта на 100, нажмите Применить (Apply), и 

закройте окно диалога. Вам может понадобиться изменить размер окна, 

чтобы увидеть все его объекты. 

□ Закройте окно Атрибуты. 

□ Используйте инструмент Редактировать аннотацию на панели 

инструментов Аннотация, чтобы разместить текст по центру внутри 

страны. 

□ Нажмите Редактор (Editor) > Завершить Редактирование (Stop 

Editing). 

□ Нажмите Да (Yes) для сохранения изменений. 

□ Уменьшите масштаб изображения до полного экстента. 

□  Закройте АгсМар  не сохраняя документ карты LabelAndAnno.mxd. 

Вы успешно создали надписи и аннотации для данной карты мира. 

 

 

 

 

 



 

 

Таблица вариантов 

 

№ 

варианта 

Целевой округ 

1 Bexar 

2 Queens 

3 Garden 

4 Addison 

5 Cascade 

6 McKean 

7 Preston 

8 Falls 

9 Woods 

10 Zavala 
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